
A guide to the SUM thesis template  

The template is based on UiO’s DUO template, and has been created by the University to 

help with the writing and submission of master's theses and student papers. 

To get started quickly with using the template, read the quick start guide. 

Downloading and saving the template 

 DUO-template for Word for Windows 2010 

The above link will open the templates. Before you can start using the template, you must store it. If you use 

Internet Explorer as your browser, it might be difficult to open the file by clicking on the link. If you encounter 

problems, right-click on the link and save the file, then open the file from the saved location. 

About versions and languages 

This guide is written on the basis of Word for Windows 2010. 

Word for Mac and other Word version may differ. Functions described in this guide are present in all 

versions. Descriptions and pictures in the guide may be slightly different than what appears on your screen. 

Menus might be structured differently, and you may need to proceed through a different number of steps as 

you follow the stated instructions. Microsoft's own pages may be helpful in determining where functions are 

placed in your version. 

 Microsoft Office for Windows (microsoft.com) 

 Microsoft Office for Mac (microsoft.com) 

This guide is based on an English Word version. If you have an English version of Windows and/or Word, 

you may find that your screen “mingles” Norwegian and English in menus and style names. This depends 

upon the setup of your PC and does not affect the program, the template or the style function. 

Do not use different versions of Word 

If you started typing in one Word version, you should not open and save the document in another one. If 

you do this, the document could be damaged or destroyed. 

Working with Styles 

Styles are specially designed sets of font, sizes and formats. Styles are stored and can be used again. It is 

recommended that you always use styles when working on a large document, especially when the 

document is required to meet formatting and typography-related requirements. Explore the various styles 

available in the DUO-template and use them as intended. Styles are also important for the creation of a 

table of contents. A table of contents is generated automatically based upon the styles of the headlines, so 

it is important that headings have the correct styles and proper hierarchy. 

View styles in a Word document 

When beginning your work with styles, click on the Home tab and locate the Styles group. 

http://www.ub.uio.no/english/publishing/students/templates/tutorial.html
http://www.ub.uio.no/english/publishing/students/templates/quick-guide.html
http://www.ub.uio.no/publisere/studenter/maler/oppgavemalWord2010.docx
http://office.microsoft.com/en-us/
http://www.microsoft.com/mac


It is also recommendable to activate the Navigation Pane to get an overview over the document. Click on 

the View tab, and check in the box for Navigation Pane.  

 

 

When you locate the cursor in your text and move the arrow to a style in the Quick Style gallery, the text will 

change temporarily, previewing how the text will look. To choose a style, click on the style in the gallery. To 

apply a style to a block of text, highlight the text and click the style in the Quick Style gallery. 

If you are curious about the style of a specific block of text, click on the text and refer to the Quick Styles 

gallery. The style of the text will be highlighted. 

   

 

If you wish to see more styles than are displayed in the Quick Style gallery, click the arrow button to the 

right of the Styles group. An additional row of styles will appear. 

  

  

To access styles from the Styles task pane, click on ‘More’ to the right of the Styles group and choose 

‘Apply Styles’. The Styles task pane will be displayed. Select the style you prefer from the menu. 

  

  

To view all available styles, click the button at the bottom right of the Styles group. The Styles window will 

be visible. If some styles are missing, you can expand the window by dragging on the lower right corner. 

  

  



Styles in the SUM template 

Name of the style Information about the style 

1 Chapter  Use for chapter headlines. Automatically numbered. Included in the table of 

contents. 

2 Section Headline level 2. Automatically numbered. Included in the table of contents. 

3 Subsection Headline level 3. Automatically numbered. Included in the table of contents. 

4 Subsubsections  Headline level 4. Not numbered. Not included in table of contents. 

Body Text Use for plain text. Use for all text not using any other style. 

Caption Use for naming figures, tables, pictures, graphs etc. Included in the table of 

figures. 

Quotes Use for quotes as well as for indented and italicized text. 

Unnumbered Header Use for headlines previous to chapter 1, such as i.e. Summary. Not numbered and 

will not be included in the table of contents.  

Bibliography and 

Appendix 

Use for headlines after chapter 1 which are not to be numbered, such as List of 

references/Bibliography and Appendix. Not numbered but included in the table of 

contents. 

Normal Not to be used. Use the style Body Text for all text not using another style. 

Front Page -stiler There are four styles for use only on the front page. 



 

Tips and advice before you start 

On word processing 

 Do not use the style Normal for plain text. Use the style Body Text. 

 Press Enter when you wish to create a new paragraph or a new item on a list. 

 Do not use Enter for line breaks. 

 Do not use the Space key to insert extra spaces. 

 This key is used only to distinguish individual words from one another. If you wish to write text in columns, 

create a table. 

 Do not use tabs. The tabs might disappear when you convert to another format. 

 Do not use the Enter key multiple times to arrive at a new page. 

 Create page breaks correctly by pressing Ctrl and Enter at the same time or by pressing the button for a 

Blank Page in the Insert tab. 

 If you wish to use "see"-references to specific pages in your paper, you must add them as cross-

references and update these cross-references before you complete the document. Page numbering 

changes continuously during the writing of a document, so if you type in a reference to a page number 

early on, it will very likely be wrong later. Adding cross-references is a feature in Word. 

Formatting columns using tables 

If you wish to present data in columns, use tables. Tables are easily created in Word, and they convert 

nicely to other formats such as HTML and PDF. Do not use the Space key to fit text into a table. The extra 

space could disappear during conversions to other formats, and you might also encounter problems with 

the format of the table in Word if you make major changes to the text. You might also think of creating a 

table with invisible borders; this makes the text look more elegant. You can find options for tables by using 

the Insert tab. 

Document properties 

 

A Word document contains "invisible information". You can reveal this hidden information by clicking on 

'File' > 'Info' > 'Properties' > 'Advanced Properties'. 

Enter correct author information. Default is the creator of the template. 

Enter the appropriate information in the form. This information will follow the file when converted to PDF. In 

an Internet search, this information will be used by the search engine (e.g. Google and DUO). It is therefore 



important that you appear as the author of the document. At the very least, you should fill out the three 

following fields: title, author and organization (University of Oslo). You can also fill out the other fields if you 

wish. 

Starting to write 

Skip the title page, table of contents and any other parts that are automatically generated. Begin by writing 

the heading for the first chapter you wish to work on. This could very well be chapter 2. 

Chapter headlines. 

Locate the correct place in the document and start typing. Sample text for the chapter headings in your 

document has been formatted with the style 'Chapter'. 

When you replace the sample text with your own text, you might notice that 'Chapter' is highlighted in the 

Quick Style gallery. The headline is now correctly formatted and will be included in the table of contents. 

You will find more information on how to generate a table of contents later in this document. 

 All chapter headings should use the style 'Chapter'. 

 Numbering of chapter headings and sub-headings is automatically generated, so do not type numbers 

yourself. 

 It is common to structure chapters in several levels according to the logical structure of the content. Be 

consistent in the use of heading levels - 'Section', 'Subsection' and 'Subsubsection'. 

 Remember that the styles form the basis for the automatically generated table of contents. 

The order of the chapters 

 You can begin by working on any chapter or any part of a chapter you choose. You may well begin with 

Chapter 2. As long as this chapter is the only chapter you are working on, it will be numbered ‘1’. This will 

change when you add chapters. 

 When starting a new chapter, locate the cursor in front of the heading for an existing chapter and select 

the style 'Chapter'. Write the heading for the new chapter; chapter numbering will be updated 

automatically. What was originally Chapter 1 will become Chapter 2. 

 By using the Quick Style gallery, you can easily switch between the styles you need. 

Plain text, use Body Text 

The style BodyText is used for plain text. Do not use 'Normal', even if you find this among the style choices. 

Paragraphs and changing styles 

To change back to Body Text after using the style 'Chapter', place your cursor at the end of the text of your 

heading and press Enter. The style will change automatically to Body Text. 

Ensure that all of your text appears in the correct style. In the illustration below, you can see different 

examples of headlines, plain text and figure titles. When you write plain text, use the style Body Text and 

press the Enter key when you start a new paragraph. If you wish to write something other than a new 

paragraph, press the Enter key and select a different style from the Quick Style gallery. 



 

 

Using elements (images, figures, etc.) from other documents or applications 

You can use different types of images, charts and illustrations. If you are unsure about how to do this, read 

the instructions for using elements from other documents or applications. 

In order to create automatically list of tables and Figures, it is important that you right click and Insert 

Caption.  

Completing the document 

Cover, title page etc. 

Title, subtitle etc. should be placed on the cover and title pages. These fields have been formatted into your 

document.  

  

http://www.ub.uio.no/english/publishing/students/templates/other-elements.html


Preface, summary, copyright information, dedication etc. 

After you complete the front and title page, type the text that will appear before the table of contents. A 

number of dedicated pages exist here in the template. If such a page is missing, e.g. for a dedication, type it 

in the headline style “Unnumbered Header” and the style Body Text for the text/body. 

Bibliography, EndNote and Reference Manager 

EndNote and Reference Manager are two of the most commonly used programs for keeping track of 

references. If you use one of these programs from the beginning of the writing process, you will save time 

later when you complete the reference list. If EndNote or Reference Manager is installed on the same 

computer as Word, tabs will appear in Word. 

In EndNote and RefMan, the reference list appears at the back of the document. This presents a problem, 

because Appendixes is the last headline in the template, and the list from EndNote and Reference Manager 

appears under this headline. 

How can you solve this problem? 

 Move the reference list to the right place by using 'cut & paste' or 'drag & drop'. 

 Before moving the list, make sure that 'Instant formatting' is turned on.  

o Select the EndNote tab / Reference Manager 12 tab, then the Bibliography group and click on the arrow 

at the bottom corner. Select the Instant Formatting tab and see if it is enabled. It should be. 

o For Reference Manager 11, you should go to the RefMan toolbar in Word and select the 4th icon from 

the left, 'Instant formatting'; check to see that it is enabled. 

 Move the list. It is very important to save the document immediately after you move the list. Otherwise 

two lists will exist the next time you go to get references from EndNote/RefMan. 

If your document does not include attachments, simply remove the last page called Appendix. The 

reference list from EndNote and RefMan will appear at the back of your document. 

You can, of course, write and maintain your reference list manually, but this can be challenging. 

Create a table of contents/index 

A table of contents is generated automatically based on the styles used in the headlines. It is therefore 

important that the headings in the document have the correct styles and proper hierarchy. 

You can create and update the index at any time during the writing process. When creating the table of 

contents, go to the place in your document where it says 'Table of Contents'. This where the table of 

contents appears. Note that if you type the title of figures with the style 'Figure', an automatically generated 

table of figures appears at the bottom of the index. 



 

Right click on the sample text in the index and choose 'Update Field'. 

If you make changes to the document later, be sure to update the index. 

Check list 

One of the last steps before finishing your paper is to update the index. Before generating the index for the 

last time, make sure that: 

 It is all there - summary, appendix, reference list, etc. 

 Tables, charts, photos are correctly positioned in the document. 

 You have used the right styles and there are no additional lines or ”mingled” styles, etc. 

 Line and page breaks are where you want them to be. Use Ctrl+Enter to insert page breaks if necessary. 

 Check the document layout in full screen mode. To do this, go to View tab and click on the ‘Full Screen 

Reading’ icon. 

Before you convert to PDF, make sure that: 

 The information in the file properties is correct. Title, author, organization, for example. 

 The lay out of each page is correct. Make sure that all your images and figures are there. 

 Make sure the index is correct. 

 

Save as – Save as Type - PDF 

 

Printing and submission 

You should allow four working days for your document to be printed at the Reprosentralen. More 

information regarding the submission of a thesis is available on SUM’s website on how to submitt the 

Masters Thesis. 

 

http://www.sum.uio.no/english/studies/admin/master-thesis/submitting/
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